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Introduction

The AVANT REM Speech+ represents a new era of precision in-situ verification for your office. Compact
yet rugged, this PC-Based system is USB powered and supports all ANSI and IEC Real Ear tests. The
software includes targets for DSL i/0 5.0 and NAL-NL1. A unique feature of the REM Speech+is
simultaneous, binaural Live Speech Mapping, MedRXx’s in-situ method for getting the fitting right the first
time, every time.

This manual assumes that the system hardware, software and drivers are installed and working properly.
Please refer to the MedRx AVANT REM Speech+ Installation Manual for assistance.

The scope of this manual is to get you “up and running” with the Avant REM Speech+ System. Please
consult the interactive Help System within the software for more detailed information of features and
functionality. To access this tool, press the F1 key at any time, or click the Help icon or menu item with
your mouse.

Measurement uncertainty is +/- 1 dB.

Refer to the Help files for test options and descriptions.

Also refer to the Help files for test signal characteristics, analysis, equalization methods and the effect of
analyzer setting on accuracy.
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The AVANT REM Speech+
Software

General Overview

The AVANT REM Speech+ software will either run as a part of the AVANT Software Suite (figure 1), or as
a stand-alone module (figure 2). The AVANT Software Suite can run stand-alone or from NOAH" System
or the TIMS NOAH-Compatible Office System.

The software includes a context-sensitive interactive Help System. To access this tool, press the F1 key
at any time, or click the Help menu with your mouse. This will display additional information and
instructions for the specific section of the software you are working in.
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: - AVANT
Advanced Audiometric Technology [ (A=
":‘é‘ o=
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Figure 1 The AVANT Software Suite Main Screen Figure 2 The AVANT REM Spggch+
Main Screen
Launching the REM+ Software
Stand Alone NOAH and TIMS

& Module Selection E -7 NOAH - [Session Browser]

TFg File View Window Help
AUANT BB z e
g{ﬁﬂ Fiting Measurement ] Other |

- i
rzoah iinY
MedFi Ine. [, REM|

MOAHaud 3 CtoScope AvartREM Plus

I

Licensed to: - MedRx, Inc. - SALES - SALES LICENSE, FOR INTERMAL

Cancel

1. Double click the 1. Launch NOAH.
AVANT REM+ 2. Click the Real Ear Measurement Toolbar Icon.
shortcut on your 3. Or, from the Module Selection screen, double click the AVANT
Windows Desktop. REM+ icon.
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Software Options

Basic Options

Several options are available which allow the user to customize the AVANT REM Speech+ Software to

meet their needs.

Access these options from the File Menu on
the Avant REM Speech+ Main Screen as

shown below.

+  AvantREM Plus
Function  Help

Clear Session Data

Prink Setup...

Page Setup...
Advanced Op@s. .
E:it

The Options may also be
accessed from within the

Avant REM Speech+
main program by clicking
on the Options text menu
as shown below.

File Funckion Ear

AvantREM Plus - Live Speech Mapping

Audio

Audio  Stimulus M
HL Q)} Line !:i

Rhaobeg

2

Speech
[lapping

The software allows you to set several default options as described below.

Options Pzﬂ
View, | Live Speech | REM | MHAHLS | Tump |
Plot Speech Spectium
I Vertical Giid [ Canoe
¥ Horizontal Grid
¥ Speech Sounds
St Language:
Style: [Lines - Fra—
Size: |50

¥ Hide Plots During Test

Default Ear: | Right hd

Options

View  Live Speech |REM | MHA/HLS | Tymp |

Default Level: |70 J;I
Smooth O/E:

LTAS
Threshold (dB): B0 =

Live Speech
W Show Fall Sounds
W Show Peak Sounds

Analyzer
Octave Bands: m

¥ Intemolate Curves Roling Window fsec): [15 =

Smooth

Show Targets

Dual Plat: |%/here Possible

I~ Reverse Ears

. ¥ Use Plot Antialiasing
¥ Maintain Plat Ratios

Plot Curves width: [Medium = |

1

Cancel |

Help

The View tab allows you
to set the default
appearance of the REM
test environment. Values
can be changed by using
the check boxes and pull-
down menus shown
above.

[¥ Save Together With LSM

[NALNLT =] | Setup |

[~ Show MCL
I Show Average LICL

Microphone: | Left Frobe hd

Options
View | Live Spssch RENN MHAHLS | Tymp |
Defaut Stimuius

¥ Interpolate Curves
Show Targets:
I Show KEMARa |70 ~| dB
™ Show SPL Reference Curve
™ Show REUR on REAR

Average Readings: |5 -

Speech Noise
Smocth Plots:
Default Level: |70 E
Analyzer
EsemE ’ﬂ Sample Averaging Time fsec): |0 5'

ICRA Averaging Time (sec): (15 JQ

Wicuphone: [LehPrabe 2]

3

[0k ]| comel | Heb [ ok | cemel | b |
The Live Speech tab sets The REM tab sets the
the look and behavior of the default look and behavior
Live  Speech Mapping of conventional Real Ear
function. Use the Show Measurements.
Targets pull-down to
underlay DSL 5.0 or NAL-
NL1 targets below your
speech maps.

5
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Options E‘ Options. &

view | Live Speech | AEM  MHAHLS | Tymp | View | Live Spssch | REM | MHAMLS Tyme |

HLS

o -
Default HLS Level = ¥ Show The Nom Ara Scaling: [Aute  +

HLS Simulation: [Nomal ~ v] ¥ Auto Switch Modes

Use Live 5 h b v
se Live Speech Mapping: ¥ inSPL [~ inHL ¥ Intemolste Curve

MH&

Default MHA Level [0 =
MHA Simulation: [Nomal ]

Use Live Speech Mapping ¥

[k | camced | Hep | [0k | caneel | Heb |
The MHA/ HLS tab sets If your system has a
the default look and Tympanometer connected,
behavior of the Master this tab will assist in
Hearing Aid and Hearing configuring the look of the
Loss Simulator. display.

NOTE: Remember, that more information is always available in the Interactive Help System by clicking
the Help Icon or pressing the F1 key.

Advanced Options

The Advanced Options screen allows you to
configure your system to meet your individual Y Function Help
clinical needs. It also provides MedRx Clear Session Data
Technical Support with tools for helping you Print Setup. ..
troubleshoot problems. Access this screen Page Setup...

from the File Menu on the Avant Main Screen Options. .

as shown to the right.

Exit

The key features of each tab are described below. For more in-depth information, consult the
interactive Help system within the software.

Advanced Options u Advanced Options u
General WAudiu -2 | Audio-B | Video | Tympanometiy | General Audio -4 WAud\o-E | Video | Tympanomety |
[ Boost Priority During Measurements CD-ROM Drive: |D: A (VIO bR s RE M+ Audio - &
™ Multiple Maritors % Input Dervice: [ MedRs REM+ Audio - & -]
Output Mixer: | MedRx REM+ Audio - & -
I¥ Do Mot Disconnect friom NOAH when Fitting ERIAEES | sor *Aude J
InputMiser: [MedRx REM+ Audin - & =l
Input Line: [ <Detault Line> =l
System Infarmation Device Manager | Language |
Audio Properties [%
i3 Corcd | Heln | 0K Corcd | Heln |

The General Tab configures the overall Avant  Use the Audio-A Tab to select the proper

REM Speech” behavior with respect to other audio device for your Avant REM+. This tab

Windows programs, specifically NOAH. also provides access to the Windows Audio
controls.

ARP-I-MREMPT-4 MedRx AVANT REM Speech Plus Installation Manual
Effective Date: 1-24-2014



Advanced Options u

Genersl | Audio-4  Audio 'lil\/\den | Tympanomsty |

Dutput Device: | [IERGIIERY ]

Input Device: |MedFix REM-+ Audio - B -l
Output Miser: | MedRx REM+ Audio - B ~|
Input Mixer: |MedF\xHEM+Aud\D-B j
Input Line: [ <Dietault Line> |

Audio Properties
[ Cancd | el |

Use the Audio-B Tab to select the proper

audio device for your AVANT REM+. This tab
also provides access to the Windows Audio

controls.

Advanced Options u

Generaw Audio -A] Audio - B ] Yideo Tympannmw ]

Tympanometer. | [FTERRLY - Setup
oK | Cancel Help

Advanced Options u
General | Audio -4 | Audia-B deen%wmpammw |

Otoscope Input

Device: il

Alternative [nput

Device: [Not Avallable |

i3 Cancd | el |

If your system has a Video Otoscope, the
Video Tab allows you to select the
appropriate input device.

If your system has a Tympanometer
connected, use this tab to configure the
equipment according to the manufacturer’s
instructions.
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Preparing for Testing

Connecting the Probes

www.medrx-usa.com

Precision Acoustic Instruments
2R _Right
Probe

Patient Operator
Headset Headset

1. Locate the Probe Microphone case.

Left
~ Probe Speakers

MedRx
e
LR Y-

2. Connect the probe
microphones to the AVANT REM
Speech+ main unit as shown
above. DO NOT force the
connector on.

Connecting the Speaker to the Device

The Speaker is placed at a distance of about 1 meter from the patient, for normal use. The front view of
the speaker is shown below, with both the charging cable attached. The Bluetooth option is not used. The
speaker’s power cable is a USB “male A to micro-B type”, connected to the power adapter.

Speaker front side is shown. The power adapter uses the appropriate plug adapter for your area.

ARP-I-MREMPT-4 MedRx AVANT REM Speech Plus Installation Manual 8
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The power plug connects as shown. Input cable from REM “speaker” jack shown above.

Press the + button until beeping is heard. The green battery light will illuminate when charging.
The volume should be reset to maximum Turn on the speaker by sliding the white

every time the speaker is turned on, switch to the middle position. The Bluetooth

as shown above. position is not used.

ARP-I-MREMPT-4 MedRx AVANT REM Speech Plus Installation Manual
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Calibrating the Probe Tube

For reasons of infection control and reliability of results, MedRx recommends that a new probe tube be
used with each patient. To ensure accurate measurements, it is necessary to calibrate the probe

tube each time it is replaced.

1. Place a new probe tube on the
probe microphone port as shown.

2. Place the probe tube between the
calibration nibs as shown. Be
sure that the opening of the probe
tube is centered on the opening of
the reference microphone.

In the Avant REM Speech+ software, do one of the following:

e Click the
Probe -
Tube ':M
Calibration jE
Icon.

Position probe microphone between 19
and 39 inches from the loudspeaker and
click Start. The signal must be at least 70
dB to complete a valid calibration. If the
screen prompt indicates the signal is too
low, increase the volume on the
loudspeaker or move the probe
microphone assembly closer and re-start
the calibration.

Repeat for the other probe. Valid
calibrations have the same approximate
shape as the gray target curve. If the
measured calibration curve differs greatly
in shape or amplitude from the gray target
curve, replace the probe tube and re-
calibrate. If this does not correct the
problem, contact MedRx technical support
at (888) 392-1234.

e Click Tools.
e Click

. Tools Wl
Calibrate H 5
elete
Probe Tube. Delete 4l
Reset Data
video Preview Shift-Enter
Probe Monitor
Calibrate Probe Tube
| [ k [
Probe Calibration E
Microphone: |F\\ghl Probe j

Reference Level. | 0 dB
- Place probe tube an top of the reference microphone.

- Start calibration

- Adjust the volume so that the Rel. Level iz above 70dB

Start h

_M

View Help Close

The calibration date is available under the Function > Calibrate > Calibration Information tabs. Return
Probe Microphones to MedRx for annual re-calibration.

ARP-I-MREMPT-4 MedRx AVANT REM Speech Plus Installation Manual
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Positioning the Speakers

Proper positioning of the
loudspeakers relative to
the patient’s hearing
aids is critical for making
accurate and repeatable
measurements. Seat the
patient so their ear is
between 19 and 39
inches from the
loudspeaker.

19 ” _ 39 ”
(48 -100 cm)

Make sure the grill of the loudspeaker is level with and directly in front of the patient’'s head.

When using Live Speech inputs, position the patient so the mouth of the person speaking is in the same
position as the loudspeaker shown here.

ARP-I-MREMPT-4 MedRx AVANT REM Speech Plus Installation Manual
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Live Speech Mapping

Step-by-Step Guide to Live Speech Mapping

Ensure the Audiogram is Entered
Before making Live Speech Mapping measurements, the patient’s pure tone audiogram must be available
to the software. This can occur several ways:
1. The audiogram was automatically entered by MedRx AVANT, AVANT Audiometer or AVANT A’D
software when testing. Then saving the NOAH session.
2. The audiogram was manually entered into the NOAHaud 3 software and saved.
3. The audiogram was entered using another manufacturer’s audiogram module.

If none of these have occurred, you may manually enter the audiometric data into the AVANT REM
Speech+ software as follows:

:- |
— - r == z]2
— - \\/
l?_ ]
E "]
= &R
1. Launch the audiometric module by clicking 2. Using your mouse, select the test ear.
on the Audio button on the right side of the 3. Select the test type Air.
AVANT REM Speech main window. 4. Enter thresholds by clicking the intersection

points with the mouse. (You may also enter
the audiogram by selecting the audio tab in
either the LSM or HLS/MHA screens).
5. Repeat for UCL (Bone and MCL optional).
6. Repeat steps 3-5 for the other ear.

After the audiogram is entered, click the Back button to return to the AVANT REM Speech+ Main screen.

1. From the AVANT REM Speech+ Main screen, click LSM.

L&D
sm [y

Lee ) 2. In the next Window. Click LSM again.
Speach

[lapping h

ARP-I-MREMPT-4 MedRx AVANT REM Speech Plus Installation Manual 12
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Speech Mapping with Live Voice Inputs

AvantREM Plus - Live Spasch Mapping

The screenshot on the left shows the

Live Speech Mapping (LSM) window.

- $ #  The system was designed to capture
= and display the human voice in the

— ear canal, so we recommend using

£ &  the microphone input and the peaks

B & measurement.

Il . = - @ wen
= = Using the microphone allows
i Wt =° pomsomat s
ik I
T R patient’s significant others.
—— e » ‘ To improve repeatability of
- £ = & measurements, it is recommended

that the speaker read a standard
passage such as the “Rainbow

Passage” which is provided on pg. 24.
NOTE: The screen shot above shows the MedRx Modified Speech Spectrum (Canoe). It is also possible

to underlay DSL i/0 or NAL-NL1 targets on this screen. Click Options in the text menu bar on the top of
the screen to select and configure these underlays to meet the needs of your practice.

Speech Mapping with Recorded Inputs

AvantREM Plus - Live Speech Mapping

ey For those who prefer a standard,

o Bt | @6 T 0l repeatable stimulus for Speech

. ~ & s Mapping, the software provides

| . . severaldigital audio files. These are
| L A accessed by clicking the File button
EEEERS = s £ = onthe right and then selecting the

1 ' - @m #  desired track from the pull-down

= =n - _Menu in the audio player.

m

3 12 = =T ok e

I

3

Once the desired track is selected,
@ o click the Start button to begin
measuring. When enough data is
T collected, click the Stop button to
" T — . stop the recording and
e ST i w = Measurement.

b

Fracuency [ Hz)

It is also possible to use an audio CD, such as the patient’s favorite music to perform Speech Mapping.
Simply click the CD button and then select a track as above. Use the sound level meter on screen to
check the proper level. Adjust the output of the speaker to desired level using the sound level meter.
(Remember conversational speech is 65 dB at 1 meter).

NOTE: The screen shot above shows the MedRx Modified Speech Spectrum (Canoe). Itis also possible
to underlay DSL i/0 or NAL-NL1 targets on this screen. Click Options in the text menu bar on the top of
the screen to select and configure these underlays to meet the needs of your practice.

ARP-I-MREMPT-4 MedRx AVANT REM Speech Plus Installation Manual
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The screen shot below provides an overview of all the tools and controls on the Live Speech Mapping
screen. For more information on these features, please consult the Interactive Help system by pressing

the F1 key or clicking the Help icon.

1. Reference Microphone Level
2. Ear selection
3. Measurement type

a. Peaks

b. LTAS

4. Input Selector

‘ AvantREM Plus - Live Speech Mapping

Open Fit Function
Reset Button
Test Interrupter
Discard, Help and Back buttons
Legend
. Target area — can be any of the following:
e MedRx Modified Speech Spectrum
e DSLilo
e NAL-NL1

Boo~NOO

File Function Ear Audio Stimulus  Options.,, Tools Help
Liu v [
‘ Audio Qj) Eu ‘ a ‘Hv-. o=n > = 2 =
I3 DD g N 45 E5 &5 /1"\
| ]
NS ﬁ" -'ﬁ
SPL (dB) SPL [dB] LeitEar | | Right Ear
120 120 il
Peaks LTAS
110 1o
\ / —_—
100+ C 100+
a0 0 g0
a0 B0
70 )\1
L:i1] i)

50

o
=}

40

=
=

w
=)

780 1k 18k 2k 3k 4k =3 = 125 250
N

| W\ -
Nl

N\

il

500 780 1k 18k 2k 3k 4k Bk 8k

Frequency [ Hz )

Frequency [ Hz ]

©® X 1€
Discard Help Back.
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Running Speech Mapping "On-Top” within NOAH

It is well established that verifying the output of hearing instruments in the patient’s ear will improve the
accuracy of the fitting. In the past, it has been difficult to verify these fittings since many real ear systems
have been disconnected from the fitting system. The AVANT REM Speech+ system is tightly integrated
with NOAH, the industry standard for audiometric and fitting data storage and retrieval. The “on-top”
mode of the REM Speech+ software allows you to effortlessly alternate between measurement and fitting
adjustments.

(5 Module Selecton ; ] Begin by opening the Avant REM Speech+
Fing  Mesuenen | over | — software from the NOAH measurement
module selection screen.

Medn— | - ([E— ¢ AvantREM Plus -

(Hosring Lazs Simudor]

NOAHaud 3 HLS Plus Visible Speech

From the Avant REM Speech” main screen,

BT = [VANT File Function Help click the NOAH LSM button. The REM
el e~ Speech Plus window will reduce in size and
= “float” on top of the NOAH screen.
(i \ P

OtoMaster l&%

Licensed to: - MedRy, Inc. - SALES - SALES LICENSE, FOR INTERNAL L

B
?% B B = Open the fitting module from the NOAH

Module Selection Screen.

Client Infrumation
8 E2 Module Selection

Fiting | Measurement | Tither |

Use the text menus and green and red
buttons in the floating LSM window to make
Speech Mapping measurements. Make
necessary changes to the instrument based
on these measurements. To make
adjustments to the hearing instrument, click
on the fitting module window and modify the
settings according to the manufacturer’s
instructions, being sure to activate, apply or
save the settings to the instrument.

Repeat this measure/adjust/measure cycle
R e until the fitting is optimized.

Completing the On-Top Mode Process

Close the REM module by clicking the X button or go up to the File menu and down to
Exit. Save the NOAH session when prompted.

Note: It is also possible to run the REM module in “disconnected” mode. In disconnected mode, the
closing of the module is different. Check the advanced options, read “Fitting with NOAH" topic in the
integrated Help System to learn more about the disconnected mode.

ARP-I-MREMPT-4 MedRx AVANT REM Speech Plus Installation Manual 15
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MedRx Live Speech Mapping Protocol

Unlike other products, the AVANT REM Speech+ system places full control over the measurement

environment firmly in the hands of the hearing care professional. The system is powerful, yet extremely
flexible, allowing each provider to use Live Speech Mapping in a way that compliments their practice style
rather than compromising it.

In order to get you “up and running” with the AVANT REM Speech+ system, MedRx has developed the
following protocol. This simple procedure has been found to be effective with both audiologists and

hearing instrument specialists. After mastering the basic operation of the system utilized in this protocol,

you are encouraged to further expand your use of Live Speech Mapping in your practice. Feature-specific
help is available by simply pressing the F1 key or clicking on the Help icon or text menu.

1.

Complete a careful otoscopic examination as instructed by
the manufacturer of your otoscope.
a. For MedRx Video Otoscopes, refer to the Help

system within the software by pressing the F1 key or Probe Tube Insertion Guide

clicking the Help icon or text menu. for Live Speech Mapping
and Conventional REM
Basic Diagnostics. e Toominetaay and Frocesiree. Aucioisgy Ontine.cam)
a. Using your audiometer and NOAH, measure and < —u |
record the following values: Adult Male (30mm)
b. Pure Tone Air and Bone conduction thresholds < o 1
c. Narrow Band Noise or Pure Tone UCL at 500, 2000 Adult Female (28mm)
and 3000 Hz < 1
d. Other tests if needed in your practice or jurisdiction Child (20-25mm)

1. Perform Otoscopic Examination

.. . . . . . 2. Align end of Probe Tube with the
Position patient as described earlier in this manual. left end of the appropriate guide
3. Align tube marker with the red

marker above

4. Place Probe Tube in ear canal
5. Confirm placement with Otoscope
6. Perform Live Speech Mapping & REM

Calibrate Probe Tube as described above.
Measure and place the probe tube in the ear canal. (Use
chart to the right).
Complete a Live Speech Mapping measurement UNAIDED.
a. Microphone input
b. Peak Measures
c. 1/3 Octave resolution

Carefully place the hearing instrument in the ear without
disturbing the probe tube.

Complete a Live Speech Mapping measurement AIDED.

Using the On Top Mode, make any adjustments needed to
the hearing instrument so that:

a. The LSM curve for Quiet Speech (50 dB) is at the
bottom of the white modified speech spectrum
(canoe).

b. The LSM curve for Conversational Speech (65 dB)
should be at the top of the white modified speech
spectrum.

c. The LSM curve for loud sounds (85 dB) (very loud
speech, clapping hands, etc.) is approximately 10 dB
below the UCL curve.

ARP-I-MREMPT-4 MedRx AVANT REM Speech Plus Installation Manual
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Real Ear Measurements

In addition to Live Speech Mapping, the Avant REM+ supports all conventional Real Ear Measurements
(REM). All these tests are accessed from the main REM screen.

To begin, click the E% s [% button on the right of the Avant REM+ main screen.
REM

In general, REM tasks are performed as follows:

AvantREM Plus - Aided Response
Fie Fundion Es Audo Taget Stus Options... Tock bl

Audo FungRx  REUR  REUG REIG REAR  REAG REOR  REOG e RECD 4 l'm,. =]
O) T s
SPL (dB] SPL |dB] - LetEx | RightEx
120 a u/”—_'\u | e
10 10 s — PR
1 »/»——‘F—u__u/"\n\ i @z —
0 90 - T ==
w01 @ Ok |-
o , = 1. Selectthe REM
@ @ RO test you wish to
j 1 g perform from
40+ 40 -
o the top row of
I o 2ye Adut
S 8 M - buttons.
hF-1 =0 5000 Tk 15 X * [ 125 =0 500 ™k 15 R O Y - Quist
iy PRl |- 2. Select the test
= @ ear.
B)x - 3. S(_elect the test
o o stimulus.

4. Click Start. The test will stop itself after sufficient data has been
collected and averaged.

5. If you wish to delete a curve, simply select it with your mouse
and then click the Discard icon or press the Delete key.

6. When all measurements are complete, click the Back arrow to
return to the AVANT REM Speech+ Main Screen.

To activate specific REM tests, click the buttons as follows:

Opens the audiometry data entry screen. Use this if audiometry has not been previously
Aude measured and entered into NOAH.

. Allows the selection of fitting rules to generate targets. The following rules are supported:
FitingRs| | 1, Gain, POGO I, POGO II, Berger, 1/3 Gain, NAL-RP, FIG6, DSL, NAL-NLL1.

Real Ear Unaided Response - Measures the additive effect of the ear canal’s resonance

REUR to a stimulus. Reported as dB SPL of output.

Real Ear Unaided Gain - Measures the additive effect of the ear canal’s resonance to a
RELIG stimulus. Reported as dB SPL of gain. If a real ear unaided response (REUR) curve has
been measured, the corresponding real ear unaided gain curve is automatically plotted to
the REUG screen.

The difference between the REUG and the REAG is called the Real Ear Insertion Gain
REIG (REIG). This Insertion Gain information is used to compare to the target gain curve
selected for the client.

The Real Ear Aided Response (REAR) is the sound pressure level in the ear canal
REAR measured with the probe microphone close to the eardrum and the operating hearing
instrument inserted in the ear and turned on. ANSI defines REAR as the SPL, as a

ARP-I-MREMPT-4 MedRx AVANT REM Speech Plus Installation Manual
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function of frequency, at a specified measurement point in the ear canal for a specified
sound field, with the hearing aid in place and turned on.

REAG

The REAG is simply the REAR expressed as gain rather than SPL. Selecting REAG
allows you to see the gain at each frequency for each of the REAR curves measured.

REOR measures the effect on the natural external ear effects resulting from inserting an

REDR

ear mold or a hearing instrument, before it is turned on, into the ear canal. The REOR is
also referred to as Insertion Loss. REOR is also useful for validating the effectiveness of

venting or canal length changes to the mold.

The Real Ear Occluded Gain (REOGQG) is the difference in decibels, as a function of
frequency, between SPL in the ear canal and SPL at the reference microphone at the

REDG

entrance of the ear canal with the hearing aid in the ear and turned off. For each REOR
measurement curve, the corresponding REOG curve is calculated and automatically

plotted to the REOG screen. The REOG function is useful in determining the acoustic seal
of a hearing aid, relative to a sound field outside the ear.

0

Some clients report they seem like they are “speaking in a barrel” or “feel blocked up”.
These are signs of a build up of self generated low frequency energy in the ear canal. This

excessive occlusion can be measured objectively in the Occlusion Effect task.

RECD

The Real Ear to Coupler Difference (RECD) is used to simulate real ear measurements by
coupler measurements and is useful when fitting children or “difficult” to fit patients. See

the section on RECD later in this manual for more detail.

Sample REM Screens

The Avant REM Speech+ system supports all current ANSI and IEC Real Ear Measurements.
The screenshots below were made using the software defaults. These defaults set the test
parameters for each test according to these standards, however the test environment is fully
configurable to meet individual professional’s needs.
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Additional Tests & Features

Real Ear to Coupler Difference (RECD)

The Real Ear to Coupler Difference (RECD) is used to simulate real ear measurements by coupler
measurements and is useful when fitting children or “difficult” to fit patients. The RECD values are used
as a correction to coupler measures for that client’s hearing instruments. By performing all subsequent
measures in the coupler and applying the RECD corrections to the coupler measures, the “real ear”
factors are incorporated into the results. The resulting simulated measurements provide information to
select and make adjustments to the hearing instrument and verify adjustments in the hearing instrument
test box rather than in the uncooperative client’s ear. This is particularly important in the case of children,
whose small volume ear canals enhance high frequency amplification more so than in average adults.
This is an essential consideration in determining the maximum output of the hearing instrument.

If RECD data is present, the software will display an option to choose between Ear or Coupler
measurement on all Real Ear screens where measurements in a coupler are appropriate.

There are two ways to measure the REAR response: using an insert headphone or a hearing instrument.

If a hearing instrument is used, its volume control setting and other parameters should remain the same
for both REAR and coupler measurements. It is also recommended to set the volume control to
moderate, and turn the compression and noise reduction circuits off.

How to perform the RECD task

First, perform the REAR task to obtain a REAR curve. This can be measured with a hearing instrument
or an insert earphone.

REAR with a hearing instrument
, e Adjust volume of the hearing instrument to comfortable listening level.
It is also recommended to turn the compression and noise reduction
circuits off.

e Position the client less than one meter from the speaker and facing
the speaker.

e Place the hearing instrument and the probe microphone tube as for all
REM measurements.

e Select START to open the measurement type selection screen.

e Choose the REAR with a Hearing Aid option.
e Select OK to begin the test and wait until it concludes.

b
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REAR with an insert headphone
e Place the probe microphone tube as for all REM measurements but
use the insert headphone instead of a hearing instrument.

e Select START to open the measurement type selection screen.

e Choose the REAR with an Insert Headphone option.

e Select OK to begin the test and wait until it concludes.

Coupler response

When the REAR is complete, you are prompted to perform a coupler response.

j e Attach the hearing instrument or the insert headphone (must be the
same as in the REAR test) to the appropriate coupler and place the
probe tube inside the coupler.

e If a hearing instrument is used, be sure to perform this measurement
at the same volume control setting as the first measurement.

e Select START to open the measurement type selection screen.

e Choose the Coupler Response option or Use Stored to skip the
measurement (see note below.)

e Select OK and wait until the test completes.

e The calculated RECD curve is automatically displayed on the screen
and is stored in memory for correction of subsequent coupler
measurements made from the RECD function.

Note: If the REAR and the coupler response were measured with the insert headphone, the program
saves the coupler response curve for later use. In this case to obtain another RECD, only REAR with
insert headphone measurement is necessary. This is possible because the coupler response does not
change provided that neither the coupler nor the insert earphone has changed.

Note: After measuring RECD, it is possible to perform Live Speech Mapping in the coupler as well. Look
for the “Measuring in” option on the LSM screen.
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Measuring Acoustic Feedback

Feedback (whistling, howling) is one of the most common complaints of hearing instrument users. Even
though many modern hearing instruments have sophisticated feedback management systems, knowing
exactly where the feedback is occurring can greatly reduce the time required to resolve the problem. The
AVANT REM" system does an excellent job measuring and displaying acoustic feedback.
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Hearing Loss Simulator

Place the calibrated probe tube in the ear canal as
instructed previously.

Place the hearing instrument in the ear without
disturbing the probe tube.

Begin a Live Speech Mapping session as instructed
previously.

When feedback is present, click the Start button.
Acoustic feedback appears as a large spike in the LSM
response.

If a more specific frequency analysis of the feedback is
desired, change the resolution of the system to 1/24
octave by clicking the Options menu item and
changing the Analyzer selection using the pull-down
menu. This image shows the same feedback as above
at 1/24 octave.

Using this information, make any needed adjustments
to the hearing instrument to reduce or remove the
feedback.

The Hearing Loss Simulator demonstrates the effect of the client’s hearing loss for the significant
third party. The program attenuates an input signal to simulate the audiogram. The third party
listens to the free field speakers. The third party can hear how their own voice is distorted by the
hearing loss when the Record input option is used.

The Hearing Loss Simulator requires the client’'s Audiogram data. This data can be manually entered in
the Audio screen of this or any other task.

ARP-I-MREMPT-4 MedRx AVANT REM Speech Plus Installation Manual 22
Effective Date: 1-24-2014



How to perform the Hearing Loss Simulator task
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4. Select Normal to play the input signal as a person with normal hearing would perceive it. Select
Simulated to turn on the simulation of the client's hearing loss. Toggle between these selections as
necessary.

5. The Reset option restores the audiogram to the original state. Use this option if you have modified
the audiogram while in the simulate mode but want to undo the changes. The changes to the
Audiogram that are made on the HLS screen are temporary and will not affect the client's original
audiometry record.

6. A volume control adjustment bar allows for manual adjustment of the output level of the freefield
speakers.

7. To stop the playback, select the Stop button on the player.

Note: It is recommended you use a variety of tracks from the list to demonstrate the hearing loss.
Record Input Option
This option allows recording and playing back of the voice of the third party.

Note: The LSM option appears on the bottom half of the display. This is so the unaided and aided results
can be displayed simultaneously for the patient and significant third party.

Master Hearing Aid

Master Hearing Aid is an alternative to using a stock hearing aid to demonstrate the benefits of
amplification to an inexperienced user. The system applies the fitting rules by default to the patient's
audiogram and simulates a hearing aid. The patient listens to this signal through the headphones.
Options for editing the gain applied to the audiogram are provided.
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About the Master Hearing Aid Display

The Master Hearing Aid screen displays a graph with dB Gain on the vertical axis and Frequency in Hz
on the horizontal axis. The plot on the graph represents the gain applied to the patient’s Audiogram. The
NAL-RP is applied by default. A new rule can be selected from the list on the right side of the display. A
volume adjustment bar allows for manual adjustment of the output level. The control panel on the right of
the display provides options for input signal source and the task icons for Normal and Simulate.

The Master Hearing Aid applies gain separately for each ear. If audiogram values are entered for the left
and right ear, the selected fitting rules will be applied to each ear separately. Different rules may be
entered for different ears (i.e. NAL-RP for left ear and BERGER for right ear). If an audiogram is entered
only for one ear, the gain will not be adjusted for the opposite ear and the sound for that ear will be
normal.

If Binaural mode is selected, the sound will be heard from both channels (left and right). If Monaural
mode is selected, the sound will be heard only from the channel corresponding to the active ear when the
channel for the opposite ear will be muted.

Input signal

Live voice (microphone) allows you to use the right probe mic for live speech input to the
headphones. The clinician or significant third party can speak into the microphone for this activity. Note:
there is a processing delay between the input and playback. Make sure that the client cannot hear the
voice directly but only through the headset. If this is not possible, use the Recorder (describer below) to
simulate speech input.

File allows the user to play sound files. The program supports MP3 and WAV files and comes with a
preset MedRx Sounds Sensations set of files. After the option is activated, use the player panel to control
the playback.

CD allows the user to play music CDs. After the option is activated, use the player panel to control the
playback.

Record input mode allows the clinician or third party to record a sample of their speech which can then
be replayed for repeat comparisons under different amplification conditions for the patient. Refer to the
interactive Help system by pressing F1 or clicking the Help icon to learn more about the recorder.
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How to use the Master Hearing Aid:

AvantREM Plus - Master Hearing Aid
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5. Select the Normal icon, which will send the input signal through to the inserts without modification.
The patient is listening to the signal without any amplification benefit. Select the Simulate icon to
modify the input signal according to the selected rule. This selection allows the patient to hear the
benefits of amplification. Toggle between these two selections as necessary.

6. If the simulated frequency response needs to be adjusted, based on feedback from the patient,
manually edit the response by clicking on the gain curve at the desired frequency and new gain
level. The gain curve of the selected test ear on the control panel can be edited. To edit the other
ear, click the appropriate test ear icon on the control panel first.

> Lilasle Hint: Use _the track return icon on the player control panel to replay one
EQ) ™ track continuously.

The Reset option restores the rule to the original state. Use this option if
you have modified the rule but want to undo the changes.

ARP-I-MREMPT-4 MedRx AVANT REM Speech Plus Installation Manual 25
Effective Date: 1-24-2014



Printing

Printing within the Avant REM+ software is very simple.

AvantREM Plus - Audiograms

=8 Function Ear Aodio  Stimuolus

| 745

Qpen
Save

Clear Session Data

Prinkt Setup...
Page Setup...
Prink Presview

G0 Back g trl-Back —

Exik &lt-F4

I an I

From the File menu, click one of the following options:

Print Setup — selects the printer you want the report to be
sent to. Avant REM Speech+ prints to any installed
Windows printer.

Page Setup — Allows you to set margin sizes and the
default text header for your reports.

Print Preview — Shows you what your report will look like
before you print it.

Print — Sends the report to the printer.
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Rainbow Passage

When the sunlight strikes raindrops in the air,
they act like a prism and form a rainbow. The
rainbow is a division of white light into many
beautiful colors. These take the shape of a long
round arch, with its path high above and its two
ends apparently beyond the horizon. There is,
according to legend, a boiling pot of gold at one
end. People look, but no one ever finds it. When
a man looks for something beyond his reach, his
friends say he is looking for the pot of gold at the

end of the rainbow.
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Limited Warranty

MedRx, Inc warrants this product to be free from defects in material and
workmanship for one year from the time of purchase. If this system fails to perform
as specified during this period, the purchaser is responsible for calling MedRx at
(888) 392-1234 or (727) 584-9600. The company's representative will advise the
owner to either return specific components or the entire system to:

MedRx, Inc.
1200 Starkey Road #105
Largo, FL 33771 USA

MedRx will repair or replace any defective devices, fully test the system and/or
components and ship the system promptly back to the owner. There is no cost for the
repair or return shipping, provided the system is one year old or less and has not
been misused, abused or damaged. Such damage includes, but is not limited to,
dropping, exposure to excessive heat greater than 100°F and water/liquid damage.

Repair or replacement of the system as provided under this warranty is the sole and
exclusive remedy of the purchaser. MedRx shall not be liable for any consequential
or incidental damages or for breach of any express or implied warranty. Except to the
extent of applicable law, any implied warranty, merchantability or fitness of this
product is limited to the duration of this warranty.

MedRx will, at its discretion, service and repair out of warranty products at the
purchaser's request, charging for parts and labor as necessary.

The limited warranty is deemed void if software or hardware is installed on this
product which is not pre-approved by MedRx, Inc. Approved software includes
NOAH" and HIMSA approved hearing aid manufacturer programming modules for
fitting hearing aids.

MedRX, Inc is not responsible for problems resulting from installation of unapproved
software or hardware. In the event of unapproved software or hardware installed on
the system causing a conflict, MedRx will service the product for a fee to be
determined at the time of service.

Any extension of this warranty past the initial one-year warranty is subject to the
following (where applicable).

1. A $300 deductible per repair.

2. Extended warranty does not include cables, connectors or peripherals.

3. Extended warranty of the Video Otoscope covers optics only.
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